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Copyrights and Trademarks

Copyrights and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. The information contained herein is designed only for use with this Epson printer. Epson is not
responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any
consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko
Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON®, EPSON EXCEED YOUR VISION, EXCEED YOUR VISION and their logos are registered trademarks or
trademarks of Seiko Epson Corporation.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.

Apple®, Macintosh®, Mac OS®, and OS X® are registered trademarks of Apple Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

© 2014 Seiko Epson Corporation. All rights reserved.

Meaning of Symbols

c Important: Important must be followed to avoid damage to this product.

Note: Notes contain important information on the operation of this product.

Operating System Versions

In this documentation, the following abbreviations are used.
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Windows refers to Windows 8, 7.
❏ Windows 8.1 refers to Windows 8.1, Windows 8.1 Pro.

❏ Windows 8 refers to Windows 8, Windows 8 Pro.

❏ Windows 7 refers to Windows 7 Professional.

Macintosh refers to Mac OS X.
❏ Mac OS X refers to Mac OS X 10.5.8/10.6.x/10.7.x/10.8.x/10.9.x.
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Installing the printer driver

System Requirements

The following operating systems support the printer driver.

Make sure your computer meets the following requirements.

Windows

Operating system Windows 7 Professional/Ultimate (SP1) 32/64 bit

Windows 8 Pro 32/64 bit

Windows 8.1 Pro 32/64 bit

Recommended computer specifications CPU: Depends on the application

Memory: 1 GB or more

HDD: 32 GB or more free space

Mac OS X

Operating system Mac OS X 10.5.8/10.6.x/10.7.x/10.8.x/10.9.x

Recommended computer specifications CPU: Depends on the application

Memory: 1 GB or more

HDD: 32 GB or more free space
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Installing the Printer Driver (Windows)

The Maintenance Tool is also installed with the printer driver. After installing, you need to update the paper
information in the Maintenance Tool.

c Important:
❏ You must log on as a user with administrative privileges.

❏ If an Administrator password or confirmation is requested, enter the password and then continue with the
operation.

A Turn off the printer and then connect the printer to a computer with a USB cable.

B Insert the software disc, and then double-click Setup.exe in the SystemApplication - Windows folder.

C Follow the on-screen instructions to install.

When the printer driver installation is complete, update the paper information (register information for a
paper type file to the printer).

D Start the Maintenance Tool.

Click Start - All Programs - EPSON - EPSON SL-D700 - SL Printer Maintenance Tool.
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E Click Printer Management.

The Printer Management screen is displayed.

F Click Update Paper Information.

The Update Paper Information screen is displayed.
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G Click Select Paper Type File.

The select file screen is displayed.

H Select a paper type file, and then click Open.

The ID for the selected paper type file is displayed.

c Important:
Make sure you select a paper type file.

Note:
Contact your local dealer for information on acquiring paper type files.

I Check that the printer is connected and turned on.

When multiple printers are connected, check all of the printers.

c Important:
Do not print while during updating the paper information.
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J Click Execute.

The paper information is updated.

A confirmation message is displayed when the update is complete.
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Installing the Printer Driver (Mac OS X)

The Maintenance Tool is also installed with the printer driver.

c Important:
❏ You must log on as a user with administrative privileges.

❏ If an Administrator password or confirmation is requested, enter the password and then continue with the
operation.

❏ Update the paper information when you install the printer driver.

A Turn off the printer and then connect the printer to a computer with a USB cable.

B Insert the software disc, and then double-click SL Printer Setup.dmg in the SystemApplication - Mac OS X
folder.

C When the screen is displayed, double-click SL Printer Setup.app.
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D Follow the on-screen instructions to install.

When the following screen is displayed, click Update the paper information - Select, and then select the paper
type file.

Note:
Contact your local dealer for information on acquiring paper type files.
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Printer Driver Functions

The printer driver coordinates print instructions from another application to the printer.

The main functions of the printer driver are described below.

❏ Converts print data received from applications into printable data and sends it to the printer.

❏ Set print conditions such as the paper type and size on the printer driver's Settings screen.

❏ Windows only ;
Start the Maintenance Tool, and then from your computer you can perform adjustment and maintenance
operations such as checking the printer's status, making settings, performing head cleaning and so on.

U "Maintenance Tool Operation Guide"

SL-D700     Printer Driver Operation Guide

Printer Driver Functions

12



Settings Screen (Windows)

Main screen

On the Main screen, you can set items and the print quality to create the best prints possible.

For more information on displaying the printer driver's Main screen, see "Basic Printing Methods (Windows)".
U “Basic Printing Methods (Windows)” on page 20
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Setting Item Explanation

Print Settings Paper Type Select the paper type to match the paper being used.

Image Quality You can select the print quality from High Speed (360 dpi), Standard (720 dpi), or
High Image Quality (1440 dpi).

Normally, select Standard. If you want to print using high image quality, set High
Image Quality. If you want to print quickly, set High Speed. When High Speed is
set, the printing speed is quicker, however the quality may decline a little.

Color
Management

Select the color management method used when printing.

U “Color Management” on page 30

Paper Size Set the paper size used for printing.

Paper sizes not in the list can be registered to User Defined.

U “Printing on Non-regular Paper Sizes” on page 44

Borderless Select to print without borders (margins).

Select Auto Expand or Retain Size as the borderless method.

When Auto Expand is selected, set the amount of enlargement.

U “Borderless Printing” on page 40

Expansion When Auto Expand is selected in Borderless, you can set the amount of
enlargement with the slider.

Orientation Click Portrait or Landscape to select the print direction. Make sure you match this
with the direction set in the application.

Copies Copies Set the number of copies.

Collate Select when printing multiple copies of a multi-page document to output collated
copies.

Reverse Order Prints pages in reverse order.

Display Printer Status Displays the printer's status. Allows you to check the amount of ink remaining, the
free space in the maintenance cartridge, and the paper settings on the printer.

U “Settings Screen (Windows)” on page 13

Advanced Settings This should not normally be used. Only use this when specified in an application.

Driver Settings is displayed.

U “Driver Settings Screen” on page 15

Start SL Printer Maintenance Tool Starts the Maintenance Tool.

See the "Maintenance Tool Operation Guide" for more details on the Maintenance
Tool.

U "Maintenance Tool Operation Guide"

Language Select the printer driver's display language.

Auto Select automatically selects the language to match the operating systems
language.

Reset Defaults Returns all settings to their defaults. Paper sizes saved in User Defined are not
deleted.
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Status Monitor screen

On the Main screen, click Display Printer Status to display the Status Monitor screen.

Setting Item Explanation

Printer Status Displays the printer's status.

Ink Levels Displays how much ink remains.

Information Displays detailed information for each ink cartridge.

Maintenance Cartridge Service Life Displays the free space in the maintenance cartridge.

The capacity is reset automatically when the maintenance cartridge is
replaced.

Paper Setup from Printer Displays the width and the remaining loaded paper.

Set the Paper Level in the Maintenance Tool.

Print Queue Displays the print queue list.

This allows you to delete or pause print jobs.

Driver Settings Screen

On the Main screen, click Advanced Settings to display the Driver Settings screen.
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Setting Item Explanation

Allow ICM settings for application software Select this if the application's ICM settings have been enabled and the print
results are not as you expected. This does not normally need to be selected.

Reset Defaults Returns settings to their defaults.
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Settings Screen (Mac OS X)

Page Setup Screen

On the Page Setup screen you can set the paper size and direction.

For more information on displaying the printer driver's Page Setup screen, see "Basic Printing Methods (Mac OS
X)".

U “Basic Printing Methods (Mac OS X)” on page 25

Setting Item Explanation

Copies Set the number of copies.

Pages Set the print range.

Paper Size Set the paper size used for printing.

Paper sizes not in the list can be registered to User Defined.

U “Printing on Non-regular Paper Sizes” on page 44

Orientation Set the paper direction.
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Color Matching screen

When selecting Color Matching from the list, you can set ColorSync from the color management system provided in
Mac OS X.

Setting Item Explanation

ColorSync / Off (No
Color Adjustment)

Set whether or not to use ColorSync. You can use ColorSync when printing from applications that support
color management.

Profile Set the printer profile used for color management.
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Print Settings screen

When selecting Print Settings from the list, you can set the paper type and image quality.

Setting Item Explanation

Paper Type Select the paper type to match the paper being used.

Image Quality You can select the print quality from High Speed (360 dpi), Standard (720 dpi), or High Image Quality
(1440 dpi).

Normally, select Standard. If you want to obtain higher quality prints, set High Image Quality. If you want
to print quickly, set High Speed. When High Speed is set, the printing speed is quicker, however the
quality may decline a little.

Borderless Select to print without borders (margins).

U “Borderless Printing” on page 40

Expansion Settings When performing Borderless printing, set the amount of enlargement to Max, Mid, or Min.
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Basic Printing Methods (Windows)

Printing from PhotoShop

This section uses Adobe Photoshop CS6 as an example of printing image data on your computer.

Operations may differ depending on the application software being used. See the manual supplied with the application
software for more details.

A Start Adobe Photoshop CS6, and open an image.

B Click Image Size from the Image menu to display the Image Size screen.

C Set the image size and resolution.

Select Constrain Proportions, and match the Width and Height settings to the paper size.

Set the Resolution. In this example, we set 360 pixel/inch.

When you have finished making settings, click OK.
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Note:
You can create clear print outs by setting the Resolution so that a multiple of this setting is the printer's Image Quality
resolution.

We recommend setting multiples of 180 pixel/inch because the settings for Image Quality are either High Speed (360
dpi), Standard (720 dpi), or High Image Quality (1440 dpi).

D Click Print from the File menu to display the Print Settings screen.

E Select this printer from Printer on the Main screen, and then click Print Settings.

F Make the necessary settings.

Paper Type: Set the paper being used.

Image Quality: Normally set Standard. If you want to print using high image quality, set High Image Quality.
If you want to print quickly, set High Speed.

Paper Size: Set the size of the paper used for printing. Make sure this is the same as the image size you set in step
3.
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U “Settings Screen (Windows)” on page 13

When you have finished making settings, click OK.

G Set each item, such as color management and print position, while checking the image displayed on the Print
Settings screen.
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Note:
❏ When the printer driver's Color Management is set to Color Controls (default), select Document in Color

Management, and then select Printer Manages Colors in Color Handling.

U “Color Management” on page 30

❏ When performing detailed color management using the PhotoShop functions, match the Color Management
conditions to these settings. See the manual supplied with PhotoShop for more details on each function.

U “Color Management” on page 30

H Click Print.

Note:
If the image size is larger than the print size, the following screen is displayed.

Click Proceed. If you click Cancel, printing is canceled and you are returned to the application's screen.

I Select this printer, and then click Print.

Print data is sent to the printer.

Note:
This screen may not be displayed depending on the application. After performing step 8, print data is sent to the
printer.

This completes this section.
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Canceling Printing

This section explains how to cancel printing.

You can cancel printing from the computer while data is being sent.

A Double-click the printer icon on the Taskbar to display the Print queue.

B Click Printer - Cancel All Documents.

To delete specific print data, select the print data, and then click Cancel from the Documents menu.

Note:
❏ You can also display the Print queue screen by following the steps below.

❏ Windows 7: Click Start - Devices and Printers - "EPSON SL-D700", and then click See what's printing.

❏ Windows 8: Point to the top right or bottom right of the Desktop to display Charms, click Search, and then click
Control Panel. Click View devices and printers, "EPSON SL-D700", and then click See what's printing.

❏ You cannot delete print data that has already been sent to the printer.

This completes this section.
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Basic Printing Methods (Mac OS X)

Printing from PhotoShop

This section uses Adobe Photoshop CS6 as an example of printing image data on your computer.

Operations may differ depending on the application software being used. See the manual supplied with the application
software for more details.

A Start Adobe Photoshop CS6, and open an image.

B Click Image Size from the Image menu to display the Image Size screen.

C Set the image size and resolution.

Select Constrain Proportions, and match the Width and Height settings to the actual paper size.

Set the Resolution. In this example, we set 360 pixel/inch.

When you have finished making settings, click OK.
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Note:
You can create clear print outs by setting the Resolution to a multiple of the printer's Image Quality resolution.

We recommend setting multiples of 180 pixel/inch because the settings for Image Quality are either High Speed (360
dpi), Standard (720 dpi), or High Image Quality (1440 dpi).

D Click Print from the File menu to display the Print Settings screen.

E Select this printer from Printer on the Printer Settings screen, and then click Print Settings.

F Make the necessary settings.

Paper Size: Set the size of the paper used for printing. Make sure this is the same as the image size you set in step
3.

Paper Type: Set the paper being used.

Image Quality: Normally set Standard. If you want to print using high image quality, set High Image Quality.
If you want to print quickly, set High Speed.
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U “Settings Screen (Mac OS X)” on page 17

When you have finished making settings, click Print.

G Set each item, such as print direction or position and color management, while checking the image displayed on
the Print Settings screen.

Note:
When performing detailed color management using the PhotoShop functions, set the Color Management to match
these settings. See the manual supplied with PhotoShop for more details on each function.

U “Color Management” on page 30
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H Click Print.

I Select this printer, and then click Print.

Print data is sent to the printer.

Note:
This screen may not be displayed depending on the application. After performing step 8, print data is sent to the
printer.

This completes this section.

SL-D700     Printer Driver Operation Guide

Basic Printing Methods (Mac OS X)

28



Canceling Printing

This section explains how to cancel printing.

You can cancel printing from the computer while data is being sent.

A Click the printer icon in the Dock.

B Select the job you want to cancel, and then click X (or Delete).

Note:
You cannot delete print data that has already been sent to the printer.

This completes this section.
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Various Print Functions

Color Management

Color Management Settings

You can perform color management using the printer driver in the following three ways.

Choose the best method according to the application you are using, the operating system environment, the aim of the
print out and so on.

Setting colors manually (Windows only)

Manually adjust the color space and color tone settings used for printing. This is useful if the application does not have
its own color management function.

U “Setting colors manually (Windows only)” on page 31

Color management from the application (no color management)

This method is for printing from applications that support color management. All color management processes are
carried out by the application's color management system. This method is useful when you want to obtain the same
color management results using a common application among different operating system environments.

U “Color management from the application (no color management)” on page 34

Color management from the printer driver

Performs color management using the operating system's color management system. Windows uses ICM and Mac OS
X uses ColorSync. This is effective in producing similar print results from different applications under the same
operating systems. However, you also need an application that supports color management.

U “Color management from the printer driver (ICM) (Windows)” on page 36

U “Color management by printer driver (ColorSync) (Mac OS X)” on page 38
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Setting colors manually (Windows only)

You can select the color space used for color management from sRGB or Adobe RGB. You can also adjust the color
tone manually while viewing a preview image.

❏ sRGB: Normally, select sRGB.

❏ Adobe RGB: Select when printing data based on the Adobe RGB color space.

When Color Controls is selected, you can fine tune the brightness, contrast, saturation, color balance, and so on.

A When using applications featuring a color management function, specify how to adjust colors from these
applications.

When using applications without a color management function, start from step 2.

Depending on the type of the application, make the settings following the table below.

Application software Color Management Settings

Adobe Photoshop CS5/CS6 Printer Manages Colors

Adobe Photoshop Lightroom 3/4

Other applications No Color Adjustment

Example of Adobe Photoshop CS6
Open the Print Settings screen.

Select Normal Printing from Color Management. Select Printer Manages Colors in Color Handling.
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B Click Print Settings to display the printer driver's Settings screen.

C On the Main screen, select Color Controls in Color Management, and then click Advanced.

D Select Mode.

sRGB: Manages colors using sRGB. Prints at the optimum color tones. This should normally be selected.

Adobe RGB: Manages colors based on the larger Adobe RGB color space. Select when printing image data
using the Adobe RGB color space information.
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E Make the necessary settings.

Color Adjustment
Method:

Select the color adjustment method.

Brightness: Adjusts the brightness of the image.

Contrast: Adjusts the contrast (difference between light and dark) of the image.

When the contrast is raised, bright sections become brighter, and dark sections become
darker. When the contrast is lowered, the difference between light and dark sections
decreases.

Saturation: Adjusts the saturation (color clarity) of the image. When the saturation is raised, colors
become vivid. When the saturation is lowered, the colors become dull until they are close
to gray.

Color Circle: When the color circle is selected as the Color Adjustment Method, you can click on the
color circle to adjust the density bar.

You can also adjust the tone by entering horizontal and vertical coordinates.

Slide Bar: When the slide bar is selected as the Color Adjustment Method, you can adjust the colors
with the slide bar.

Note:
You can adjust the correction value while checking the sample image at the top of the screen.

F Set other items if necessary, and then print.

This completes this section.
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Color management from the application (no color management)

Print using applications with a color management function. Enable the color management settings in the application
and disable the printer driver's color adjustment function.

A Make the settings for color adjustment using the application.

Example of Adobe Photoshop CS6
Open the Print Settings screen.

Select Normal Printing from Color Management. Select Photoshop Manages Colors as the Color Handling
setting, and then select the Printer Profile and the Rendering Intent.

Note:
If you are not using an original printer profile, select a profile for each paper type from the Printer Profile drop-down
menu.

B Click Print Settings to display the printer driver's Settings screen.
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C Turn off color management.

Windows: On the Main screen, select No Color Adjustment from Color Management.

Mac OS X: Select Color Matching from the list, and then click Off (No Color Adjustment).

D Set other items if necessary, and then print.

This completes this section.
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Color management from the printer driver (ICM) (Windows)

Performs color management from the printer driver. If the application does not support color management, select
Driver ICM (Basic) or Driver ICM (Advanced). If the application does support color management, select Host ICM.
When performing color management using Host ICM, use image data that contains an embedded input profile.

A Make the settings for color adjustment using the application.

Depending on the type of the application, make the settings following the table below.

Application software Color Management Settings

Adobe Photoshop CS5/CS6 Printer Manages Colors

Adobe Photoshop Lightroom 3/4

Other applications No Color Adjustment

Example of Adobe Photoshop CS6
Open the Print Settings screen.

Select Normal Printing from Color Management. Select Printer Manages Colors in Color Handling.

When using applications without a color management function, start from step 2.

B Click Print Settings to display the printer driver's Settings screen.
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C On the Main screen, select ICM in Color Management, and then click Advanced.

D Select ICM Mode.

Driver ICM (Basic): Specify the input profile used to process the entire image data.

Driver ICM (Advanced): Specify the input profile for each image such as photos, graphics, and text data.

Host ICM: Specify when printing from applications that support color management.

E Make the necessary settings.

When Driver ICM (Basic) or Driver ICM (Advanced) is selected, specify an input profile.

When Show all profiles. is selected, specify the Intent and Printer Profile.

Intent Explanation

Saturation Performs conversion, without changing the current saturation.

Perceptual Performs conversion so that a more visually natural image is produced. This feature is used when a
wider gamut of color is used for image data.

Relative
Colorimetric

Performs conversion so that a set of color gamut coordinates and white point (color temperature)
coordinates in original data match their corresponding print coordinates. This feature is used for
many types of color matching.
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Intent Explanation

Absolute
Colorimetric

Performs conversion so that absolute color gamut coordinates are assigned to both the original
and print data. Therefore, color tone adjustment is not performed on any white point (or color
temperature) for the original or print data. This feature is used for special purposes such as logo
color printing.

F Set other items if necessary, and then print.

This completes this section.

Color management by printer driver (ColorSync) (Mac OS X)

Performs color management from the printer driver. The application needs to support ColorSync. When performing
color management using ColorSync, use image data in which an input profile is embedded.

A Make the settings for color adjustment using the application.

Depending on the type of the application, make the settings following the table below.

Application software Color Management Settings

Adobe Photoshop CS5/CS6 Printer Manages Colors

Adobe Photoshop Lightroom 3/4

Other applications No Color Adjustment
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Example of Adobe Photoshop CS6
Open the Print Settings screen.

Select Normal Printing from Color Management. Select Printer Manages Colors in Color Handling.

B Click Print Settings to display the printer driver's Settings screen.

C Select Color Matching from the list, and then click ColorSync. And then select Profile.

D Set other items if necessary, and then print.

This completes this section.
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Borderless Printing

You can print your data without borders (margins).

The printer driver enlarges the print data to a size slightly larger than the paper size and prints the enlarged image. The
sections which are beyond the paper edges are not printed; therefore, resulting in borderless printing. You can set the
amount that extends beyond the edges of the paper in the printer driver.

Types of Borderless Printing Methods
You can perform borderless printing using the following two methods: Auto Expand or Retain Size.

Auto Expand
The printer driver enlarges the print data to a size slightly larger than the paper size and prints the enlarged image. The
sections which are beyond the paper edges are not printed; therefore, resulting in borderless printing.

Use settings such as Page Layout in the applications to set the size of the image data as follows.

❏ Match the paper size and page setting for the print data.

❏ If the application has margin settings, set the margins to 0 mm.

❏ Make the image data as large as the paper size.

Retain Size
Create the print data larger than the actual paper size in the applications to produce borderless output. The printer
driver does not enlarge the image data. Use settings such as Page Layout in the applications to set the size of the image
data as follows.

❏ Make image size setting so that the print data is 1.69 mm larger to the left and right than the actual paper size.

❏ If the application has margin settings, set the margins to 0 mm.

❏ Make the image data as large as the paper size.
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Select this setting if you want to avoid image enlargement by the printer driver.

Setting Procedure

Windows

A Display the printer driver's Main screen.

U “Settings Screen (Windows)” on page 13

B On the Main screen, set items necessary for printing such as the Paper Type and the Paper Size.

C Select Borderless.
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D Select Auto Expand or Retain Size as the borderless method.

When Auto Expand is selected, set the slider to set the amount of enlargement.

Note:
Moving the slider towards Mid or Min decreases the image enlargement ratio. Therefore, some margins may appear at
the edges of the paper depending on the paper and printing environment.

E Set other items if necessary, and then print.

This completes this section.

Mac OS X

A Display the printer driver's Printer Settings screen.

U “Settings Screen (Mac OS X)” on page 17

B Select the print size and borderless printing method in Paper Size.
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C When Auto Expand is selected in Paper Size, select the amount of enlargement.

Note:
Selecting Mid or Min decreases the image enlargement ratio. Therefore, some margins may appear at the edges of the
paper depending on the paper and printing environment.

D Set other items if necessary, and then print.

This completes this section.
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Printing on Non-regular Paper Sizes

You can print on paper sizes not included in the printer driver. The printer can be used with paper of the following
sizes.

Width 102, 127, 152, 203, 210 mm

Length 89 to 1,000 mm

c Important:
Depending on the application, output sizes may be restricted.

Setting Procedure

Windows

A Display the printer driver's Main screen.

U “Basic Printing Methods (Windows)” on page 20

B On the Main screen, select User Defined from Paper Size.

C On the User Defined Paper Size screen enter a Paper Size Name, set the paper size, and then click Save.
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Note:
❏ To change the registered paper size, select the paper size name from the list on the left.

❏ To delete a registered paper size, select the paper size name from the list on the left, and then click Delete.

❏ You can register up to 30 paper sizes.

D Click OK.

The size entered in the paper size list box is registered.

You can then print as normal.

Mac OS X

A Display the printer driver's Page Setup screen.

U “Settings Screen (Mac OS X)” on page 17

B Select Manage Custom Sizes from Paper Size.
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C Click +, and then enter the paper size name.

D Enter the Width and Height for the Paper Size as well as the margins, and then click OK.

Set the page size range and the printer margins according to the printing method.

Note:
❏ To edit a saved custom size, choose its name from the list on the left of the Custom Paper Sizes screen.

❏ To copy a saved custom size, select the size in the list on the left and click Duplicate.

❏ To delete a saved custom size, select it in the list on the left and click -.

❏ The custom paper size setting differs depending on the operating system version. See your operating system's
documentation for details.

E Click OK.

You can select the paper size you saved from the Paper Size pop-up menu.

You can then print as usual.
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Troubleshooting

Note:
For problems not related to the printer driver, see the "Operation Guide".

U "Operation Guide" - "Troubleshooting"

When an Error Message Is Displayed

When an error message is displayed, check the solution on the screen and take the required measures.

You cannot print (because the printer does not work)

Cause What to do

The printer driver is not installed correctly. Is the icon for this printer displayed in the Devices and Printers, Printers and
Faxes folder?
❏ Yes

The printer driver is installed. See the following item, "The printer is not
connected correctly to the computer".

❏ No

The printer driver is not installed. Install the printer driver.

Does the printer port setting match the printer connection port?
Check the printer port.

Click the Port tab on the printer's Properties screen, and check if the printer
name's port is set.

If it is not indicated, the printer driver is not installed correctly.

Delete and reinstall the printer driver.

The printer is not communicating with the
computer.

Is the cable plugged in correctly?

Confirm that the interface cable is securely connected to both the printer
connector and the computer. Also, make sure the cable is not broken nor bent. If
you have a spare cable, try connecting with the spare cable.

An error has occurred on the printer. Check the lights on the printer and the message on the screen.

See the "Operation Guide" for the solution.

The printer stops printing. Is the status of the print queue Pause?

If you stop printing or the printer stops printing because of an error, the print
queue enters a Pause status. You cannot print in this status.

Double-click the printer icon in the Devices and Printers or Printers and Faxes
folder; if printing is paused, open the Printer menu and clear the Pause check
box.
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The printer sounds like it is printing, but nothing prints

Cause What to do

The print head moves, but nothing prints. Confirm the printer operation.

See the "Maintenance Tool Operation Guide" to print a nozzle check pattern, and
then check the printer's operations and status.

The nozzle check pattern is not printed
correctly.

Perform head cleaning.

The nozzles may be clogged. See the "Maintenance Tool Operation Guide" to
perform head cleaning, and then try printing the nozzle check pattern again.

The prints are not what you expected

Cause What to do

Print quality is poor, uneven, too light, or
too dark.

Are the print head nozzles clogged?

If the nozzles are clogged, specific nozzles do not fire ink and the print quality
declines. See the "Maintenance Tool Operation Guide" to perform a nozzle check.

Are the Paper Type settings correct?

Make sure the Paper Type settings on the printer driver's Printer Settings screen
match the paper to be printed on.

Have you compared the printing result with the image on the display
monitor?

Since monitors and printers produce colors differently, printed colors will not
always match on-screen colors perfectly.

The color is not exactly the same as
another printer.

Colors vary depending on the printer type due to each printer's
characteristics.

Because inks, printer drivers, and printer profiles are developed for each printer
model, the colors printed by different printer models are not exactly the same.

The print is not positioned properly on the
paper.

Have you specified the print area?

Check the print area in the settings of the application and the printer.

Are the paper size settings correct?

If the option selected for Paper Size in the printer driver does not match the paper
size (width) loaded in the printer, the print may not be in the correct position or
some of the data may be printed over the edges of the paper.

Check the Paper Size setting on the printer driver's Printer Settings screen.

Margins appear in borderless printing. Are the settings for the print data in the application correct?
Make sure that the paper settings in the application are correct as well as in the
printer driver.

U “Borderless Printing” on page 40
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Uninstalling the Printer Driver (Windows)

Note:
❏ You must log on as a user with administrative privileges.

❏ In Windows 7/Windows 8, if an Administrator password or confirmation is requested, enter the password and then
continue with the operation.

A From the Control Panel click Uninstall program (or Add or remove programs).

B Select "EPSON SL-D700 Software", and then click Uninstall (or Del).

C Follow the on-screen instructions to continue.

When the delete confirmation message appears, click Yes.

The Maintenance Tool and the printer driver are removed at the same time.

Restart the computer if you are reinstalling the printer driver.
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Uninstalling the Printer Driver (Mac OS X)

Use the "Uninstaller" to uninstall the printer driver.

Downloading the Uninstaller
Download the Uninstaller from the Epson website.

http://www.epson.com/

Using the Uninstaller
Follow the instructions on the Epson website.
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